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ABOUT THIS PARTICIPANT GUIDE

This document serves as a supplement to the training courses offered through Unanet
University. Participants should use this workbook to complete exercises in the student
Unanet CRM system. Additionally, participants should record notes and actions for
reference when working within their own Unanet CRM system.

Symbols used in this guide

0 Activity o Important Note

@ Demo Question
@ Tour

Unanet Contact Information
e VirtualUU@unanet.com

Send questions here for information about courses, course schedules,
unanetuniversity.com, certifications, and enroliments. Unanet monitors this mailbox
daily.

Student Training Site

Students can use their Sandbox site to support this course. Students must have login
credentials to log in as the Overall Firm Administrator (OFA). The Sandbox system
should include Personnel, Companies, Contacts, Opportunities, Projects, and business
processes to complete the designed activities sufficiently.


mailto:VirtualUU@unanet.com

COURSE INTRODUCTION

In this course, you will review tasks specific to general administration of the system to
configure value lists, field labels, and custom fields for all record types. You will also
complete tasks for system cleanup of records, configuring and creating forms, utilizing
the user manager, creating dashboards and customizing widgets, running reports, using
the knowledge module, creating workflows, and configuring firm setup.

Learning Objectives
After this session for Unanet CRM by Cosential: Administering the System,
participants will be able to

e Customize basic firm settings and e Configure a Project Record
understand navigation e Configure Projects Administration

e Configure a Personnel Record e Utilize the User Manager to Set

o Utilize My Preferences Permissions

e Configure a Company Record ¢ Set Up and Distribute

e Configure a Contact Record Dashboards

e Configure a Lead Record ¢ Run and Analyze Reports

e Configure an Opportunity Record ¢ Create and Maintain the

e Create and Publish a Form Knowledge Module

e Utilize Contact Manager e Create and Set Up Workflows
Administration e Configure Firm Setup as the OFA

Unanet CRM by Cosential provides CRM and Marketing Functionality. The graphic
below outlines system features that apply to each and the user type for which these
features are best. The Overall Firm Administrator can control access through
permission settings.

Features Features

Actionable Dashboards Outlook
CRM Functionality .
Bast fowr S Reports
o Doy sasllors
» Project managori Contacts Publisher
= Field reps
Email Marketing

Personnel (Resumes)

N

Projects, Surveys




Administrator Roles

Every firm has one Overall Firm Administrator (OFA) assigned by Unanet CRM. Only
the OFA can access the Firm Setup tab in Administration, administer the Activities
module, and assign Administrator access to other users. To change the OFA, please
get in touch with Unanet CRM Support.

The OFA can assign other users as Administrators. Administrators have complete
access to all of a firm's active modules (except Administration > Firm Setup) and can
view, edit, and delete records, change value list fields, and administer other firm
settings.

We recommend limiting the number of Administrators because the system does
not log Administrator modifications to your firm's settings.

10



LESSON 1: CUSTOMIZE BASIC FIRM SETTINGS AND
UNDERSTAND NAVIGATION

Learning Objectives
Find field customization and explore functionality

[ ]
Find value lists and explore functionality

Introduction
Unanet CRM by Cosential provides a single source of truth for your entire project

lifecycle, from meeting an individual contact to completing a successful project. The
graphic below shows the modules that support this process.

o o ©

Lead Opportunity Project
Rumor of a Potential Project Potential Project Contracted Work
Create a Lead record. Asyou learn  Track the information in the (Active or Complete)
more about it, verify if it is a viable  Opportunity record until it is won Once the Project record is
them as Contact records. When  Opportunity and convert it to an or lost. If you win the Project, created, supplement it with the
the Contact shares a potential Opportunity, or disqualify the Lead.  convert the Opportunity record data you will need to market the
project with you, determine if it to a Project record. If you lose contracted project.

is a Lead or an Opportunity. the Project, change the
Opportunity Stage to Closed Lost.

Contact

Company
Potential Client Staff

Potential Client
Find a Potential Client and create
a Company record.

As you develop relationships with
people at this Company, enter

) ® O

Publisher 4.0 Personnel
LlFECYCLE OF A PROJ ECT Non-Project Specific Publishes Dynamic, Your Firm's Staff
Information and Formatted Documents
Boilerplates Use your Cosential data to create
Opportunity Profiles, Knowledge
Profiles, Project Profiles, Project

IN COSENTIAL
Lists, and Resumes in Adobe

InDesign and/or Microsoft Word.

Knowledge

Information flows from Lead to Opportunity to Project as you convert them through the
lifecycle. The core data modules that store and track your data are Companies,
Contacts, Leads, Opportunities, Personnel, and Projects. Many of the key

categorizations are shared across record types.
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Administration Menu

Find the Administration menu in the header bar's top-right corner next to the User
Profile picture, which is indicated by an icon displaying hammer and wrench tools. In
this menu, you will find:

e General Administration e Personnel Administration
e Activities Administration e Projects Administration
e Contact Manager Administration e App Market

General Administration's homepage displays Recent Account Activity, updated
information, and multiple tabs. There are two rows of tabs, with the frequently used
items at the top.

Activities Administration contains the Event Manager Administration window that
allows you to add or remove Call Log types and dispositions, add Personnel groups,
and enable Phone System Integration.

Contact Manager Administration includes Value Lists, cleanup tools (Mass Updates,
Mass Removal, Merged Updates), and Data Manipulation Tools.

Personnel Administration is where you can merge one Personnel record into another.

Projects Administration contains Project Fields, Project Value Lists, Data
Manipulation Tools, and the Project Merge Tool.

General Administration Menu

Hover over General Administration to view contents. We cover the most frequently used
items in the General Administration dropdown: User Manager, Firm Setup, Workflow
2.0, Value Lists, Field Customization, and Custom Fields. We address these areas in
this course, but let’s explore Field customization and Value Lists now.

Field Customization

This area allows you to turn on and off and relabel fields, which allows for matching to
your company terminology or perhaps repurposing fields. The types of fields that allow
customization found in the menu are:

e PROJECTS > Project Fields Display e CONTACT MANAGER > Opportunity

e CONTACT MANAGER > Contact Fields Display
Fields Display « PERSONNEL > Personnel Fields
e CONTACT MANAGER > Company Display

Fields Display



« KNOWLEDGE > Knowledge Fields « PRODUCTS > Product Fields Display
Display

Within each area, you can add a Custom Label, a Custom Tool Tip, toggle the Tool Tip
on or off, or Enable or Disable the field via the Viewable toggle. Tool Tips display when
hovering over the field when toggled on.

The Project Fields Display area also allows you to toggle on and off Size fields to
display in the Project Summary.

The Company/Contact Fields Display areas allow you to toggle on or off fields and
make them Required.

The Opportunity Fields Display takes you to the Opportunity Configuration area.

Some fields exist in multiple places, such as Primary and Secondary
Categories shared by Projects and Opportunities.

Tour 1.1 - Find Field Customization and explore functionality
Tour the options available in the Field Customization menu and learn the
purposes they serve.

0 Activity 1.2 — Edit a Personnel field and add a custom label

Activity Steps
1. Click the Administration Ed button
a. Hover over General Administration
b. Select Field Customization from the secondary dropdown menu
In the PERSONNEL section, open Personnel Fields Display
Scroll down to the Office Contact History section
If not already off, Toggle the Viewable button to “Off’ for Pager
Scroll up to the Personnel Details section

Click the edit pencil icon (¢ for “Other Info”
a. Add Custom Label: “Date of Birth”

7. Click the Save icon

o akwbd
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Value Lists

Value lists are a set of dropdown options across different record types. You can choose
between Single-Select and Multi-Select functionalities in the Preferences section. You
can add, remove, or edit a value within a section by finding a button labeled +Add, a
"new" value button, or a text field that says New Value, accompanied by a Save button.

Some Value Lists come pre-configured, while others can be customized. Remember
that some Value Lists are shared across different record types, so modifying them
affects all records that use those values.

Deleting a value from a value list already selected in a record creates a ghost
association where the value still appears but does not exist in the database.

@ Tour 1.3 — Locate value lists and explore functionality

0 Activity 1.4 — Open the Primary Categories value list and
remove an item

Activity Steps
1. Click the Administration EQ button
a. Hover over General Administration
b. Select Value Lists from the secondary dropdown menu
2. Scroll down to the PROJECTS section and Open Primary Categories
3. Find Agricultural at the top of the list and click delete
4. Click OK in the pop-up window to confirm

0 Activity 1.5 — Open the Regions value list and disable an item

Activity Steps
1. Click the Administration Ed button
a. Hover over General Administration
b. Select Value Lists from the secondary dropdown menu
Open Project Region in the PROJECTS section
3. Find Caribbean near the top of the list and click the Viewable eye icon to toggle
it off
4. Click the Save button at the top of the screen

N
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Check your understanding

The modules considered core data modules that store and track all of your
data are

a) Companies

b) Contacts

c) Leads

d) Opportunities
e) Personnel

f) Projects

g) All of the above

Value Lists are located in

a) General Administration
b) Activities Administration
c) Contact Manager Administration

Q Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 2: CONFIGURE A PERSONNEL RECORD

Learning Objectives
e Navigate and configure a Personnel record
e Modify the Education value list

Introduction

The Personnel module manages your marketable staff information efficiently. This
module lets you quickly assemble winning project teams and generate dynamic
resumes. Personnel records store a wide range of information such as bios/intros,
education, skills/training, memberships, current and previous project experience,
awards, and references. These records can be associated with the core data modules:
Firm Orgs, Activities, Knowledge, and Goals, making it easier for you to manage your
organization's marketable staff effectively.

On the Personnel overview screen, you see an alphabetical list of all personnel. The
first column includes icons representing whether a record is for a User, Unassigned
Personnel, Admin, or Firm Admin.

© = Firm Admin, @ = Admin, & = User, £ = Unassigned Personnel

Upon opening a Personnel record, you see several tabs in the top row, including
Personnel Summary, Project Experience, Education, Training/Skills, Registrations, and
Awards. These tabs are some of the more often used and help populate resumes for
proposals.

The Firm Organization area includes value lists created and maintained by the
Administrators. It allows you to categorize core data across all modules.

TIP: If your firm has enabled the Make User button, then your Administrators can click
on that button and convert this person into a user by adding that person to one of the
existing user groups. There is no Make User button if the person is already a user.

Education Value List in Personnel Record
Degree is the only field on the Education tab that pulls from a value list. Note: School is
a required field.

16



0 Activity 2.1 — Modify the Education value list

Activity Steps

1. Click the Administration button
a. Hover over General Administration
b. Select Value Lists from the secondary dropdown menu
Scroll down to the PERSONNEL section
Open the Education Degrees link
4. Add a new value to the list
a. Type “JD” into the New Value text field
b. Click Save
5. Edit the first value “AA” to read “Associate of Arts”
c. Click the edit pencil icon to the left of “AA”
a. Type “Associate of Arts” in the Edit Value window
b. Click Save

w N

Check your understanding

True or False
Personnel records store data used for resumes.

Q Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 3: UTILIZE MY PREFERENCES

Learning Objectives
e Change password
e Set preferences to associate yourself with New Opportunities

Introduction
When you click on your user profile picture, a menu appears with options to access your

Personnel Record, Preferences, and log out. Selecting Preferences leads you to a
PERSONAL and CONTACT MANAGER section.

Password

In the PERSONAL section, you handle password and login preferences, home page,
and auto-login preferences, and set your default Country.

The Change Password function in My Preferences is straightforward and works as
expected. Changes are effective immediately, and passwords do not expire. Users may
reset their password by going to the login screen and clicking the “Forgot your
password” link. This process also works as one would expect.

Administrators can reset a user’s password, which we cover in Lesson 12.

@ Demo 3.1 — Reset a password as a user

Demo Steps

Open User Profile

Open My Preferences
Select Change Password
Enter your Old Password
Enter a New Password:
Re-Type New Password:
Click Save

Nookowh=

Opportunity Preferences

In your MY PREFERENCES > CONTACT MANAGER section, you change the default
view for listing Company records and how to associate yourself to newly created
Opportunity records automatically.

18



Users set up their associated Opportunity Staff Team Role in the Opportunity
Preferences area. They are automatically associated with this role whenever they add a
new Opportunity. Note: Administrators should help users understand that this
preference is available to help expedite workflows that create Opportunities, filter My
Opportunities, and utilize the Opportunity Grid.

0 Activity 3.2 — Set Opportunity Preferences to Associate Self

to Record

Activity Steps

Part 1: Associate self to Opportunity record

1.

o

6.
7.

Click on your User Profile

2. Open My Preferences
3.
4. Check the box for “Automatically associate yourself to Opportunities you create

Open Opportunity Preferences under the CONTACT MANAGER section

as”

Open the dropdown menu

Select Assistant Project Manager
Click Save

Part 2: Check that the association populates a record
1. Add a new Opportunity by clicking the Create New + icon in the upper-right

2.
3.

Scroll down to the Opportunity Associations section
Confirm that Staff Team and Staff Role are pre-populated

Check your understanding

My Preferences includes options to

a) Create a Dashboard
b) Upload profile picture
c) Associate yourself to a record

0 Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 4: CONFIGURE A COMPANY RECORD

Learning Objectives
e Navigate and configure a Company record
e Modify the Company-type value list
e Modify Company fields to be required

Introduction

In Unanet CRM, the information flow begins with the Company record and your firm’s
relationship with them. Think Client, Owner, Prospect, or Consultant. This module is
where you manage the information you have for the companies you are doing business
with and those with whom you are pursuing business.

First, the Company summary page displays associations with other records. It provides
a complete overview of your firm’s relationship with the Company.

The Company record is the foundational data of the CRM. Neither Contacts nor
Opportunities can be entered into the system without an associated Company record.

Check for similar company names before creating a new record. The CRM

system displays potential duplicates as you type. If you find one, cancel and
confirm you are not creating a duplicate record.

Company Record Value Lists

In the Value List menu of the Company section, there are multiple value lists. However,
the company type is the most commonly used. Use the Company Types value list to
classify the companies you interact with. This value list can be either single-select or
multi-select.

Use The Available on Dropdown option to include or exclude a specific value from the
list. By selecting "No," the list does not display the value, but the data associated with it
stays in the records. We recommend hiding them from the dropdown vs deleting values
from value lists.

Removed values move to the list called "Removed Company Types." You can
choose to either re-add the value or delete it completely. If you decide to
delete it, the system alerts you to associated companies using that value.
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0 Activity 4.1 — Modify the Company Type value list

Activity Steps

1. Click the Administration button
a. Hover over General Administration
b. Select Value Lists from the secondary dropdown menu
Scroll down to the COMPANIES section
Open the Company Types link
Add a new value to the list by clicking the +Add button
Enter the following information into the Add Company Type pop-up window
a. Type Other Financial into the Company Type Name text field
b. Select a Label: Yellow
c. Select a Company Type Group: Client
6. Click Save

abkwn

0 Activity 4.2 — Modify Company fields to be required

Activity Steps

1. Click the Administration Ed button
a. Hover over General Administration
b. Select Field Customization
2. Open Company Fields Display in the second section for CONTACT MANAGER
3. Click to expand the Address section
4. In the Required column, turn on the following fields (click to expand section)
a. Address1 e. Phone

b. City f. Postal Code
c. Country g. Website
d. State

Check your understanding

Which record requires a Company record for association?

a) Contact record
b) Opportunity record
c) Both Contact and Opportunity record

O Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 5: CONFIGURE A CONTACT RECORD

Learning Objectives
e Navigate and configure a Contact record
e Relabel Contact Category to Personal Interests
e Modify Contact Type and Mailing List value lists
e Create a custom value list for “Golf Shirt Size.”

Introduction
The Contacts module allows you to manage the information you have for the people you
are doing business with and those with whom you are pursuing business.

Even though there are several ways to add a new Contact, such as quickly clicking the
Create New + icon in the upper-right corner and selecting Contact, we recommend you
review the Company > Contacts table first to help avoid duplicates.

Please also search the database for the person as they may be a contact for a company
they previously worked for.

You are automatically associated with the Contacts you create. You can associate more
people to the record after you create it.

Field Customization in the Contact Record

Field customization is a useful practice for several reasons. One reason is to repurpose
the field. One field in the Contact record generally used for this is the Contact Category,
which is turned off by default and not in use. Many firms use this multi-select field to
collect information regarding hobbies or interests.

Activity 5.1 — Turn on and relabel Contact Category to
Personal Interests

Activity Steps

Part 1: Relabel

1. Click the Administration EQ button
a. Hover over General Administration
b. Select Field Customization from the secondary dropdown menu
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In the CONTACT MANAGER section, open Contact Fields Display
Scroll down to the Other Information section

Toggle the Viewable button to “On” for Contact Category

Click the pencil icon in that row to edit

Input a Custom Label of “Personal Interests”

Click the save icon

NoOooakwd

field labels. If you need to modify your field's value list, you must locate the

0 It is important to note that the Value List page does not reflect customized
field by its original label.

Part 2: Add values

1. Click the Administration Ed button
a. Hover over General Administration
b. Select Value Lists from the secondary dropdown menu
Scroll down to the CONTACTS section
Open the Contact Category field
Add a value using the +Add button in the upper-right of the page
Input “Golf” into the Contact Category Name box in the pop-up window
Add another value using the +Add button in the upper-right of the page
Input “Guitar” into the Contact Category Name box in the pop-up window

NookowdN

Value Lists in the Contact Record

The Contact record has several value lists. An Administrator can modify or add values
to meet your company’s needs. The below activities include suggested additions to
better use the value list.

For Contact Type, some default types might include Accounting Contact, Coordination
Contact, Decision Maker, Influencer, Manager, or Personal.

For Mailing Lists, these values determine who receives what mailings.

0 Activity 5.2 — Modify Contact Type and Mailing List value lists

Activity Steps

Part 1: Modify Contact Type

1. Click the Administration button
a. Hover over General Administration



b. Select Value Lists from the secondary dropdown menu
Scroll down to the CONTACTS section
Open the Contact Types field
Add a value using the +Add button in the upper-right of the page
Input “Marketing Contact” into the Contact Type box in the pop-up window
Click Save

IS

A marketing contact could be useful to indicate if you are doing business
together or perhaps submitting a partner proposal.

Part 2: Modify Mailing List

Open the Value Lists tab in the top row of the toolbar

Scroll down to the CONTACTS section

Open the Mailing Lists field

Add a value using the new mailing list button in the upper-right of the page
Input “Holiday Cards 2024” into the Mailing List Name box

In the Available on Dropdown menu selection, choose “Yes”

Click add to mailing list

Mailing List Types is an option that needs selection if you have a third-party

email marketing integration.

In the Mailing Lists value list, it is often best practice to use the Available on
Dropdown menu option to disable the mailing list from future selections.

Custom Fields in the Contact Record

Custom Fields can be added to Projects, Opportunities, Contacts, and Companies by
an Administrator.

Add up to 5 custom fields of each type for all modules except Opportunities. In
Opportunities, you can add up to 200 for each type. Custom Field Types include:

e Date - Entered as mm/dd/yyyy (or dependent on date localization settings)

e Text Area - Large text field holding over 15,000 characters, including spaces
e Currency - Any whole-number dollar value formatted as dollars and cents (for
example, 1000=$1,000.00)

Number - Numbers of any size, formatted with commas

Percentage - Any whole number from 0 to 100

Short Text - Small text field holding up to 50 characters, including spaces
Value List - A dropdown list of single-select customizable values
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It is best practice to repurpose an existing field whenever possible before creating a
custom field.

0 Here are a few important procedures to note:

1. You cannot change the customer field type once you've created it.

2. You cannot delete a custom field. You can only remove it and delete all data
held in that field.

3. To re-purpose a removed custom field, edit the name of a custom field with
the field type you require (including any associated values if it is a Value
List) and click the "Re-Add" button to re-add it to the system.

4. Custom Value Lists are single-select only. If you need an additional multi-
select Value List, review your current lists and see if you can re-purpose
one you are not using or switch data around to free up a multi-select list.

0 Activity 5.3 — Create a Contact Custom Field for Golf Shirt
Size

Activity Steps

Part 1: Create a custom field
1. Open the General Administration menu
Open the Custom Fields tab in the top row of the toolbar
Open Custom Contact Fields
Click the + Custom Field button
In the pop-up window, select Value List
Input “Golf Shirt Size” into the Field Label box
Click Save

Nookowd

Part 2: Add values to the Golf Shirt Size value list
1. In the newly created row for Golf Shirt Size, click the Value List text in the Field
Type column
In the pop-up window, input “Men’s Small”’ in the New Value box
Click Save
4. Input “Men’s Medium” and “Men’s Large,” and click Save each time.

w N
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Check your understanding

What is the best practice for adding a new Contact?

Q Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 6: CONFIGURE A LEAD RECORD

Learning Objectives
e Navigate and configure a Lead record
e Modify the Lead Stages value list by adding “Assigned/Opened”

Introduction
The Leads module is optional, where you manage the information you have for the leads
you are tracking.

You can add a Lead without associating it with other core data modules. Or associate with
Company, Contact, Personnel, or Firm Org values. You can create a Lead record by clicking
the Create New + icon in the upper-right and selecting Lead.

Only a Lead Name is required to create a Lead record. This optional module lets you track
rumors or long-range pursuits before enough information to determine a viable opportunity.

NOTE: To convert a Lead to an Opportunity, you must associate a Client Company records
with the Lead record.

Value Lists in the Lead Record
The Lead record has several value lists. Leads, Opportunities, and Projects share value
lists. Configure them under General Administration > Value Lists.

Some essential lists specific to Leads are Stages, Record Sources, and Lead Scores. The
Stages value list has default values of “Closed,” “Convert to opportunity,” and “Unassigned.”

0 Activity 6.1 — Modify the Lead Stages value list by adding
“Assigned”

Activity Steps
1. Click the Administration button
a. Hover over General Administration
b. Select Value Lists from the secondary dropdown menu
Scroll down to the LEADS section
Open the Stages field
Add a value by selecting the New Value text field at the top of the page
Input “Assigned” into the New Value text field
Open the Status dropdown and select Open

ok wN
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7. Click Save

Check your understanding

True or False
Leads can be entered without associating with any other core data modules.

G Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 7: CONFIGURE AN OPPORTUNITY RECORD

Learning Objectives
¢ Navigate and configure an Opportunity record
e |dentify and discuss value lists shared between records
e Modify value lists for Stages, Categories, and Contact Role
e Relabel fields for Dollar and Date
e Add or remove fields for Dollar and Date
e Create a custom text field for “Proposal Date/Time Submission”
e Modify Opportunity fields to turn fields on or off or make the fields required

Introduction
The Opportunity module allows you to manage the information you have for the
opportunities you are pursuing and tracking.

The best practice for adding a new Opportunity is to start from the Company, where you
have a +Opportunity button in the Opportunity section. This method ensures you associate
the Opportunity with the correct client (company). You can see the entire list of associated
opportunities to ensure you are not creating a duplicate.

To convert a Lead into an Opportunity, open a Lead and click the Convert to Opportunity
button in the upper-left corner.
Remember, use the Opportunities Quick Search tool and ensure you are not
creating a duplicate record.
The Opportunity form includes a shortcut panel on the left that helps you jump to different
sections of the form, and there is a search box to find specific fields directly. The blue “More

required” button helps ensure you don’t miss the required fields. Pressing the blue button
jumps you directly to the required fields that are incomplete.

Value Lists in the Opportunity Record
The Opportunity record has various essential value lists: Stages, Submittal Type, Win
Probability, Prospect Type, and Contact Role.

The following value lists are also significant but not unique to the Opportunity record. These
are shared as the key information flows through the project lifecycle.
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Firm Org categorizations allow you to categorize (organize) your data to mirror your
firm. The six baked-in Firm Orgs are Offices, Divisions, Office Divisions, Studios,
Practice Areas, and Territories. These are present in all of the core data modules.

Primary and Secondary Categories, Project Contracts, and Project Service types
are shared with Leads and Projects.

Client Type, Construction Type, and Delivery Method are shared with Projects.

See Appendix B — Sample Value Lists for recommended values for some of the mentioned

value lists.

Activity 7.1 — Modify value lists for Stages, Contact Roles, and
Primary Categories

Activity Steps

Part 1: Add a field to the Stages value list

1.

Nookwd

Click the Administration button
a. Select Contact Manager Administration
b. Select Administrate Opportunity Fields to open Opportunity Configuration
In the Lifecycle section, click the Value List link for the Stage field
Add a value using the +Add button in the upper-right of the page
Input “07.1-Submitted Roster” into the Stage Name box in the pop-up window
Open the dropdown menu for Stage Type and select Pending
Input “60” into the Probability text field
Click Save

Part 2: Add a field to the Associated Contact Roles value list

1.

Click the Value Lists link at the top

2. In the OPPORTUNITIES section, open the Associated Contact Roles field
3.
4
5

Add a value by typing in the New Value in the text field at the top of the page

. Input “Bid Contact” into the New Value text field
. Click Save

Part 3: Add a field to the Associated Contact Roles value list

1.

2.
3.
4.

Click the Administration EQ button

a. Hover over General Administration

b. Select Value Lists from the secondary dropdown menu
In the PROJECTS section, open the Primary Categories field
Click the New Category button in the upper right
Input “Airport Terminal” into the text field

30



5. Select the Yes radio button for Available on Dropdown menu
6. Click add category

Stages Value List
Opportunity Stages represent your incoming work or your pipeline. It is vital to reach a
consensus on your Stages with management, business development, and marketing staff.

Associated Contact Role Value List

Contact Role applies to Leads and Projects and is a key value for tracking relationships and
identifying key Contacts throughout the lifecycle of a project. Manage this value here:
General Administration > Value Lists > OPPORTUNITIES > Associated Contact Roles.

Primary Categories Value List

Primary Categories is the main method to organize your information. This is a key value
throughout the lifecycle of a project as well. This value list is managed from the PROJECTS
section.

Field Customization in the Opportunity Record

0 Activity 7.2 — Relabel Dollar and Date fields

Activity Steps

1. Click the Administration EQ button
a. Hover over General Administration
b. Select Field Customization from the secondary dropdown menu
In the CONTACT MANAGER section, open the Opportunity Field Display link
Find Factored Fee in the Metrics section
Click the ellipses left of Factored Fee
Select Edit Field from the dropdown menu to open the Edit form
In the Custom Label box, type “Weighted Potential Revenue”
Click Save
Click the expand icon at the left end of the header bar to collapse all
Click the expand icon on the left side of Lifecycle and find the Est. Selection Date
10 Click the ellipses left of Est. Selection Date
11. Select Edit Field from the dropdown menu to open the Edit form
12.In the Custom Label box, type “Client Decision Date”
13.In the Custom Tool Tip box, type “When the client makes a decision”
14.Click Save

©CONSO RN
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Administrate Opportunity Fields
This section covers the Opportunity Configuration Grid and how to make Opportunity fields
required when creating and editing Opportunities.

The following navigation paths all lead to Opportunity Configuration:
e Administration > Contact Manager Administration > Administrate Opportunity Fields
e Administration > General Administration > Field Customization > Opportunity Fields Display

e Administration > General Administration > Custom Fields > Opportunities

Opportunity Configuration Area

The Opportunity configuration provides the following information for all standard and custom

opportunity fields:

e Field Name — The standard default field display name
e Custom Field Name — Manually entered text to relabel a standard field name
e Field Type — Checkbox, Currency, Date, Hyperlink, Number, Percentage, Rich Text,
Short Text, Value List
o Custom field label — For New Custom Fields, an informative label displays to
represent the custom field.

o Legacy field label - An informative label will be displayed to represent the custom

field for legacy Custom Fields.

e Enabled —Toggle on/off to make field visible or hidden on data entry forms

e Required - A value in this field is required to save a new Opportunity. (The system
requires a Company/Client, Opportunity Name, Status, and Stage for all records).

e Read Only by Stage — Lists all Opportunity Stages to conditional set the field as read-
only when the Opportunity reaches the desired Stage.

e Custom Data Entry Forms — Lists custom Opportunity forms on which an Admin can
set the field as conditionally required.

e Enable on grid - Makes the field available on the Opportunity Grid.

o Edit on grid — Allows you to edit the field on the Opportunity Grid.

e Tooltip — Once you have added a tooltip, it is visible here, and when a user hovers over
the field

The ellipse to the left of the field name allows you to manage individual fields:
e Standard Fields

o Clicking the ellipses on a Standard field allows an administrator to edit the field

e New Custom Fields
o An administrator can perform the following actions when they click the ellipses
on a New Custom field type:
= Edit Field - Copy Backend ID - Hide Tool Tip - Delete - Manage Value
List
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e Legacy Fields
o Clicking the ellipses on a New Custom field type allows an administrator to
perform the following actions:
= Edit Field - Copy Backend ID - Hide Tool Tip - Delete - Manage Value
List

0 Activity 7.3 — Add or Remove Dollar and Date Fields

Activity Steps
1. Click the Administration Ed button
a. Select the Contact Manager Administration menu
2. Inthe OPPORTUNITIES section, open the Administrate Opportunity Fields link
3. Find Quals Due Date in the LIFECYCLE section
4. Turn on the Enable toggle

0 Activity 7.4 — Modify Opportunity fields to turn fields on or off or
make the fields required

Activity Steps
Part 1
1. Click the Administration button
a. Select Contact Manager Administration
In the OPPORTUNITIES sections, select Administrate Opportunity Fields
In the LIFECYCLE section, select the ellipses next to Quals Due Date
Select Edit Field
Select Required from the Required dropdown
Select Save

S

Part 2
1. Select the ellipses next to the Expected RFP Date
2. Select Edit Field
3. Check the box next to Enable on Grid
4. Check the box next to Edit on Grid
5. Select Save

Part 3
1. Select the ellipses next to RFP Received
2. Select Edit Field
3. Select By Stage from the Required dropdown



4. Select the following stages from the dropdown (note, your stage values may be
different)
a. 02-Received RFP
b. 03-Submitted RFQ
c. 06-Submitted RFP
d. 07-Shortlisted
e. 10-Closed Won
f. 11-Closed Lost
5. Select Save

Custom Fields in the Opportunity Record
An Administrator can add Custom Fields to several areas of the CRM, such as Projects,
Opportunities, Contacts, and Companies.

You can add up to 5 of each custom field type for Projects, Contacts, and Companies, with
up to 200 for Opportunities.

Custom Field Types include:

o Checkbox — Add a checkbox with description text

Currency - Any whole-number dollar value formatted as dollars and cents (for
example, 1000=$1,000.00)

Date - Entered as mm/dd/yyyy (or dependent on date localization settings)
Hyperlink

Number - Numbers of any size, formatted with commas

Percentage - Any whole number from 0 to 100

Rich Text - Large text field holding over 15,000 characters, including spaces
Short Text - Small text field holding up to 50 characters, including spaces
Value List - A list of single-select customizable values to be selected from a drop-
down list.

0 Here are a few important procedures to note:

1. You cannot change the field type of a custom field once it has been created.

2. You cannot delete a custom field. You can only remove it and delete all data
being held in that field.

3. Custom Value Lists are single-select only. If you need an additional multi-select
Value List, review your current lists and see if you can re-purpose one you are
not using or switch data around to free up a multi-select list.
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Activity 7.5 — Create a custom text field for Proposal Date/Time
Submission

Activity Steps

1. Click the Administration Ed button

a. Hover over General Administration

i. Select Custom Fields from the secondary dropdown menu

In the CONTACT MANAGER section, open the Opportunities link
Click Add Custom Field on the top-right side of the table
In the pop-up window, in the Field Name box type “Proposal Due Date and Time”
For the Section dropdown menu select Lifecycle
For the Field Type dropdown menu, select Short Text
Click Save

Nookwd

Check your understanding

It is best practice to add an Opportunity record from
a) the + Create New menu
b) a Contact record
c) a Company record

o Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 8: UTILIZE CONTACT MANAGER
ADMINISTRATION

Learning Objectives
e Discuss Mass Updates, Mass Removal, Merged Updates, and Data Manipulation
Tools

Introduction

Contact Manager Administration is a menu that allows you to configure Value Lists,
administrate Company and Opportunity fields, and use cleanup tools such as Mass
Updates, Mass Removal, Merged Updates, and Data Manipulation Tools. This menu can be
accessed from several places. The quickest access is from the Administration icon in the
top-right corner of the header bar, next to the User Profile picture, indicated by an icon
displaying hammer and wrench tools. It is also accessible as a blue text link at the top of the
Companies, Contacts, Leads, and Opportunities modules.

Mass Updates/Mass Removal/Merged Updates/Data

Manipulation Tools
Mass Updates, Mass Removal, and Merged Updates are in the Contact Manager
Administration menu.

The Mass Updates and Removal sections include functions mainly for Contacts, with some
Company cleanup. These are intended to provide methods to make changes in bulk to clean
up or enhance your data. One Mass Update function deals with Opportunities to
Associate/Unassociate Opportunities to Projects.

©
©

Merged Updates provides functions that allow you to clean up and consolidate data through
merging records and/or identifying duplicates.

Tour 8.1a — Discuss Mass Updates

Tour 8.1b — Discuss Mass Removal

@ Tour 8.1c — Discuss Merged Updates
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Data Manipulation Tools includes three functions to help make data changes/updates for
large groups of records. The Company Data Update Tool and Contact Data Update Tool
allow you to update Firm Org data for the appropriate records. The Opportunity Data Update
Tool adds another layer of functionality, including Primary and Secondary Categories, to the

data that can be updated.

@ Tour 8.1d — Discuss Data Manipulation Tools
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LESSON 9: CONFIGURE FORMS

Learning Objectives
e Create a Form
e Publish a Form

Introduction

This lesson covers the administrative functions of the Forms feature. Learn how to create
and publish Forms to use on Opportunities within CRM.

Features and Benefits

Forms provide a flexible way to gather additional information about your Opportunities within
CRM. This feature allows you to:

e Create custom Forms to support your business processes, such as Go/No Go Forms
and Proposal Checklists

e Utilize various question types to gather the type of data that is most important to your
processes

e Optionally require and score question responses to ensure you gather the
appropriate amount of data

e Create Workflow notifications based on Form status and score

Use Cases
Use Forms for various purposes associated with Opportunities within Unanet CRM,
including:

e Go/No Go e Proposal Checklist e Conflict of Interest
e Strategy to Win e Debrief ¢ Request for Resources

Tour 9.1 — Discuss Forms

Access the Forms Dashboard here: Admin tool icon > General Administration
> Forms. Create forms using templates or from scratch.
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Creating Forms

Create from Template

When creating a Form from a template, we provide Admins with a great starting point that
can save time when developing a Form from scratch. Admins have complete control to
change all aspects of the template before saving and publishing, including:

e Modifying the name and description

e Adding additional questions

¢ Removing/modifying provided questions

e Adding conditional requirements to the Form

e Adding/modifying conditional display logic of individual questions

The following Opportunity Form templates are available:

e Go-No Go Simple e Debrief ¢ Gate Review forms
e Go-No Go Advanced e Checklist

0 Activity 9.2 — Create a Form from a Template

Activity Steps

1. Click the Administration button
2. Hover over General Administration
a. Select Forms from the dropdown menu
Click on Create from Template
Select the template from the drop-down list to open the form-build-page
Rename your template
Add a Section title
Hover over the left edge of question 2 for a 4-directional arrow to appear
Drag and drop question 2 before question 1
9. Click on question 1 and check the box next to Required
10.Select Save
11.Notice the new Form in your Drafts section

©® N OE W

Create A Form from Scratch

To create a new Form, click "Create from Scratch" at the top of the page. Add questions and

a title/description. To duplicate a Form, click the three-dot menu and select "Duplicate."
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The following question types are currently supported:

o Short text — gathers a short text response

o Long text — gathers an extended text response

« Radio button — allows the user to select a single option from a set of admin-
determined responses

e« Checkbox — allows the user to select multiple options from a set of admin-

determined responses

Date/Time — gathers a date/time response

Currency — gathers a currency response

Number — gathers a numerical response

Percentage — gathers a percentage response

Rating — gathers a rating response in “stars”

Likert — measures opinions, attitudes, or behaviors as a flexible scale response

The Forms section displays previously added forms and allows you to add more

@ Tour 9.3 — Discuss Forms Section in Opportunity Record
forms to the Opportunity.

NOTE: You may add a form to an Opportunity you are currently editing.

Check your understanding

True or False
The Go-No Go Form is the only template provided.

Q Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 10: CONFIGURE A PROJECT RECORD

Learning Objectives
e Navigate and configure the Project record
e Associate relationships to a Project

Introduction

The Marketing side of the Unanet CRM System includes the Project and Personnel Core
Data Modules and various Output and Support modules. The data tracked in these modules
is used to generate resumes, project profiles, and reports to help demonstrate your firm’s
expertise.

A Project record stores and interrelates project-specific data. Information includes a project
directory (Owner/Client, Consultant, and Staff Team), financials (Fees/Contracts, Costs,
and Change Orders), logistics (Schedule and Size), marketing (Images, Awards,
Publications, Descriptions, and References), and other documentation (Documents, Emails,
and Archiving).

Key project relationships include associations with companies and contacts (such as
owners, clients, consultants, and references), staff teams (your personnel), and the
relationship to the original opportunity.

@ Tour 10.1 — Identify and discuss Project record fields and tabs

Before creating a new Project record, please ensure you are not creating a duplicate.
Specific fields are required when adding a new project via the main menu or from the
Project Grid. Once those fields are populated and you click Create Project, you see the
Project Summary page. Click edit to add or make changes to the summary page.

Other information is stored in Project records and broken into several tabs, which you can
view by clicking. Each tab has buttons for editing and associating data. When you are done
editing within any tab, click the “Save” button.

The Images tab has its own Project Image Manager tool. You can find thumbnail
previews, metadata, and download capabilities for uploaded Project images here.
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0 Activity 10.2 — Create a Project record

Activity Steps
1. Click the Create New + icon in the upper-right and select Project
2. Add a Project Name (required)
3. Scroll down and Select the Create Project button to open the new record
4. In the new record, Scroll down to Project Categories/Types
a. Select the icon left of Primary Categories and make a selection
i. Click Submit
Select Services Type(s)
Select Construction Type
Select Delivery Method
e. Select Project Client Type
5. Identify Firm Organization information
a. Select the icon left of Offices and make a selection
i. Click Submit
6. Associate a Client/Owner (Companies can be associated with Projects as Client,
Owner, Owner’s Rep, or Consultant Companies)
a. Select the Owner/Client tab
b. Select +Company to open the Add Owner/Client panel
c. Search for and select a Company
d. Select Company Type Role
e
f
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. Mark if this is a confidential Owner/Client
. Add any comments
g. Select the Save button
7. Associate a Contact (Contacts can be associated with Projects as Client Contact,
Owner Contact, Owner’s Rep, or Consultant Contacts, as well as Project References)
a. Select +Contact to open Add Owner/Client Contact
b. Search by OwnerClient Company from Company previously associated
i. Select Save
ii. Check any Contact
ii. Select Save
8. Select Contact Role (value list created by OFA)
a. Click the Edit pencil icon for the Owner/Client Contact just created
b. In the pop-up window, Select an OwnerClient Contact Role from the
dropdown list
c. Select Save
d. Check Box Create Reference Record (Selecting this option creates a
Reference record on the Project Reference tab. To remove this Project
Reference, you'll need to go to the Reference tab and delete the record.)
e. Add Testimonial Text to Associated Contact



NOTE: Both records display links to one another if the Project was created by converting an
Opportunity into it.

9. Select References Tab

a. Select the View icon next to the newly added reference

b. In the pop-up window, select + Add next to Testimonials

c. Add Testimonial Text

d. Select Save
10. Associate Personnel (You associate your Personnel with your Projects as “Staff

Team members”)

Select the Staff Team tab
Select the +Add Staff link to open the Add Staff window
Search for and select Staff Member
Select Staff Role (this is another Admin-created value list)
Add Staff Team Hours
Add Percent Involved
Add Start/End Dates
Add a Description of their role/involvement in the project

i. Select Save
11. Add Cost/Schedule details (Depending on your firm's setup, you may see different

tabs)

12.Add Size

a. Place cursor in the text field for Building Size

i. Enter a numeric amount
b. Place the cursor in the text field for Size Type
i. Select SF for square feet from the dropdown

13.Add a Project Description
Select the Descriptions Tab
Select the +Add to the right of the PROJECT DESCRIPTIONS header to open
the Add a Description window (Required fields highlighted in blue)
Select Type — Proposal Short from the dropdown menu
Check box Project Resume Description
Add Description text (required)
Select Save

TQ@ 0 o0 T
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Convert To in the Opportunity record > GENERAL INFORMATION section

0 You can always create a Project by converting an Opportunity into a Project. Select
heading.

ConvertTo =+ Opportunity /' Edit B Delete



Check your understanding

Which tab in the Project record has its own management tool?

True or False
A Project can be created from the Opportunity record.

O Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 11: CONFIGURE PROJECTS ADMINISTRATION

Learning Objectives
e Administrate Project fields
e Discuss Project data and merge tools
e Configure and customize the Project Grid

Introduction
To access Projects Administration, click on the Administration icon at the header bar's top-
right corner. It's next to the User Profile picture and displays hammer and wrench tools.

In Projects Administration, you can configure project-related fields, value lists, and the
Project Grid. Additionally, you will find the Project Data Manipulation and Merge Tools here.

Configure Project Fields

If you want to customize, include, or exclude fields on Project records, select the Project
Fields Display link under Modify Project Field Display. You can find columns for custom
labels, tooltips, and a Viewable toggle to include or exclude a field.

@ Tour 11.1 — Configure Project fields

Data Manipulation Tools

The Projects Administration menu has two data manipulation tools: Project Data Update
Tool and Associate/Unassociate Opportunities to Projects. The purpose of these tools is as
follows:

Project Data Update Tool — Use this Data Update Tool to change data for large groups of
Projects. For example, let's say you are closing your Baltimore office, and the New York
office will now handle Baltimore’s Projects. Use the Product Data Update Tool to make this
change with minimal effort.

Functions for the following fields: Primary Category, Secondary Category, Offices, Studios,
Practice Areas, Divisions

Associate/Unassociate Opportunities to Projects — Use this tool to link and unlink an
Opportunity to one or more Projects. Note: This tool is also accessible here: General
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Administration > Contact Manager Administration > Data Manipulation Tools > Opportunity
Data Update Tool.

@ Demo 11.2 — Associate Opportunities to Project Records

Demo Steps

1.
2.
3.

o o

© N

Click the Administration EQ button

Select Projects Administration

In the Data Manipulation Tools section, select Associate / Unnassociate
Opportunities to Projects

In the first box, Link an Opportunity to a Project (1 of 2), search for and select an
Opportunity

Click Select

For the second box, Link an Opportunity to a Project (2 of 2), search for and select
a Project

Click Select

Select OK

Project Merge Tool

The Project Merge Tool is a feature that enables users to merge data from one project to
another. When using this tool, the CRM system adds data to the project record that you
want to be the master project. Importantly, it only adds data that is missing from the master
project. The declared master project is then retained and updated with the associations of
the duplicate project. However, it's important to note that you must manually delete the
project that you merged into your master project.

Refer to Appendix B — Project Merge Fields and Associations for updated fields and
associations based on existing merge functionality.

@ Demo 11.3 — Utilize Project Merge Tool

Demo Steps

1.

Click the Administration button

2. Select Projects Administration

3. Scroll down to the Project Merge Tool section

4.

5. In the first box, Project -, select a Project record you want to merge into another.

Select Merge One Project to Another Project

ALERT: CRM does not automatically delete the record after you merge it. You must
delete the record manually.
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6. In the second box, Merged Project -, select the project you want to be the “master”
Project (into which CRM merges the first project)
7. Click Save

NOTE: After you have merged the Project records, you must delete the duplicate Project
record(s) manually. And name the master back to the original name.

1. Enter the Project name in the search bar

2. Select the pencil icon Edit button

3. Select Delete

Project Grid

The Overall Firm Administrator (OFA) can make the Project Grid the default landing page for
the Projects module vs. just seeing a list of projects. The Project Grid allows you to add
specific fields to the grid view, which can be edited, filtered, sorted, and grouped like Excel
spreadsheets. Turn on the Project Grid view here: General Administration > Firm Setup.

Use Case: Project Managers
e View your projects, identify missing data, and make updates so the Marketing and BD
teams can find relevant experience and respond to RFPs.
e Search for specific projects and update details as the project progresses to ensure
Marketing has the most up-to-date information for responding to RFPs.

Use Case: Marketers
e Search for relevant experience to help with go/no go decisions.
e Verify project data's completeness to confidently use your firm’s project experience
when responding to RFPs.

Use Case: Business Developers/Seller-Doers
e Search for relevant experience to ensure the work you want to pursue aligns with
your firm’s experience.
e Prepare for meetings with prospects by reviewing similar past projects for them, other
clients, or in the same geographic area.

0 Activity 11.4 — Configure Project Grid

Activity Steps

Part 1: Enable Project Grid and Manage Columns
1. Click the Administration button
a. Hover over General Administration
b. Select Firm Setup

47



N

ok

7.
8.

Use CTRL+F and search “Project Grid”
Ensure Yes is selected
a. Ifitis not, select Yes and click Save
Next, Select Projects from the left-side navigation menu
Click the gear icon in the top-right grid header
In the Manage Columns window
a. Turn on/off columns in the Project Grid in the left column
b. Reorder columns by dragging and dropping to change the column order
Select Save
Hover over a column header and drag to a new position

NOTE: Depending on settings, you and your users can click and edit fields directly within
the grid

Part 2: Enable and allow editing to Staff Roles

1.

2.

3.

4.

Click the Administration button

a. Select Projects Administration
Open Project Grid Options from the Modify Project Field Display section at the top
of the page
Check the boxes for Grid-Enable and Grid-Edit next to the Staff Role(s) you want
permissioned
Select Save

Check your understanding

True or False
The Administrate Project Fields menu is used to customize fields and include or
exclude fields on Project forms.

0 Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 12: UTILIZE THE USER MANAGER TO SET
PERMISSIONS

Learning Objectives
e Create user groups
e Set user permissions for a group
e Populate group with users
e Send login/reset password message

Introduction

The process of setting up users in the system consists of two steps. Firstly, we need to
create personnel records. Secondly, we must assign personnel to user groups. The User
Manager tool simplifies the process of adding new groups, finding user details and
permissions, managing login and password, as well as keeping track of the groups that have
already been created.

Default user groups included in the system are Personnel: No Access; Overall Firm
Administrator; Administrators, No Group, Full User Group, CRM User Group.

0 Activity 12.1 — Create user groups

Activity Steps
1. Click the Administration button
a. Hover over General Administration
b. Select User Manager from the secondary dropdown menu
2. Click the + New User Group button at the top-left of the module
3. Type “Users: Seller Doer User Group” into the Name field
4. Click Create Group

User Group Permissions

Manage User Permissions in the bottom pane of the User Manager module. The first tab
summarizes the set permissions. The second tab lists all modules in the left and the
individual keys in the right pane.

When setting up permissions for User Groups, three User levels can be defined within most
Modules. They are Full, Self, or Firm Org.

Full — User can read, edit, and delete every record within the assigned module
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Self — User can only read, edit, and delete records they created
Firm Org — User can only read, edit, and delete records that match their Firm Org
associations within their Personnel record

Each of the three levels is combined with the following to define itself within the various
modules:

Read - can read data on records
Write — can edit or write data to records
Delete — can delete entire data records

For a newly created user groups, all keys are turned off by default, and appear read. You
can turn on keys by clicking the red lock icon, which will close the lock and turn the icon
green.

To turn on many keys at once instead of one by one, you can click Full Write to
turn on Full Read. If granting delete permissions, you can turn on Full Delete,
which will turn on Full Write and Full Read. This will also turn on corresponding
Self-labeled and Firm Org-labeled keys if included in that module.

Use Appendix B — Permission Lists as a resource for setting recommended permissions for
your user groups.

0 Activity 12.2 — Set user permission groups
For demonstration purposes, permissions will be turned on just for Contact
Manager modules.

Activity Steps
1. Click the Administration Ed button
a. Hover over General Administration
Select User Manager from the secondary dropdown menu
2. In the top-left pane, select the Seller Doer User Group
3. At the top of the bottom pane, select the Users: Seller Doer User Group
Permission tab
In the bottom-left pane, select Contact Manager
Click on the red lock icon for Full Delete
In the bottom-left pane, select Activities
Click on the red lock icon for Full Delete
In the bottom-left pane, select Leads
. Click on the red lock icon for Full Delete
10.In the bottom-left pane, select Opportunities
11.Click on the red lock icon for Full Delete
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Populating User Groups

In User Manager, the first group, Personnel: No Access, contains all employees at your
company that has a Personnel record. You can select users from here or use the Find User
search toolbar to locate users.

Your company must have enough licenses purchased to add users to groups that
require a license.

0 Activity 12.3 — Add user(s) to a user group

Activity Steps
1. Click the Administration Ed button
a. Hover over General Administration
b. Select User Manager from the secondary dropdown menu
Select the Personnel: No Access user group in the left pane of the module
Scroll down and select the user Angie Rose
Notice that the bottom pane now shows the User Detail tab
Select the + Move to group dropdown
Choose Users: Seller Doer User Group
Confirm by clicking Move User

Nookwd

Passwords
In User Manager, Administrators can reset passwords for users. In Demo 3.1, it is also
addressed that users can reset their own passwords.

@ Demo 12.4 — Send login/reset password message

Demo Steps

1. Click the Administration button
a. Hover over General Administration
b. Select User Manager from the secondary dropdown menu
Find Ben Smith via the search box
Ensure Ben Smith is selected via the checkbox
In the bottom pane, ensure the User Detail matches the selected user
Click the Reset Password button in the lower pane User Detail
Click the Send Login Information button
Verify subject and message, then make any desired updates
Click Send

PN EWN
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Check your understanding

True or False
Permissions must be set on a user group before adding users.

° Refer to Appendix A for answers to the Check Your Understanding questions
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LESSON 13: SET UP AND DISTRIBUTE DASHBOARDS

Learning Objectives
e Set up a firm-wide dashboard and share it as the firm default
e Set up a business development dashboard

Introduction

A Dashboard is a central location where you can install widgets to access and analyze
information and data. You can have multiple dashboards containing multiple tabs and
widgets. Tailor widgets to meet your specific needs. Most of our widgets display charts and
graphs, and most are Opportunity-related.

Manage dashboards on the Home page. There is a Dashboard dropdown menu to select
from different Saved Dashboards, and there is a Dashboard Settings button where you can
do the following:

e Dashboard Items — add/remove widgets. Listed by module

e Dashboard Options — select a theme color, customize the layout

e Saved Dashboards — set a dashboard as the firm default, share/unshare a
dashboard, and delete

e Exported Widgets (OFA/Admin only) — lists widgets exported to embed in other
websites

e Administration (OFA/Admin only) — make widgets available to users to include in
their dashboards

Activity 13.1 — Setup a firmwide dashboard and share it as firm
0 default

This activity guides you in adding recommended widgets, but not customize them,
as these are very flexible to meet each firm’s needs.

Activity Steps
1. Go to the Home page

ashboard: General Dashboard -

2. Open the Dashboard: snapshot selector dropdown menu ‘= at the top left
of the dashboard

Select General Dashboard (name in your firm may be different)

Open the Dashboard: snapshot selector dropdown menu and select Save
Dashboard As

In the pop-up window, type “Firmwide Dashboard”

Click OK

B w
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7. Open Dashboard Settings at the top right of the dashboard
8. In the Tab Title, type “Metrics”
9. In the Layout dropdown, select 3 Column
10.Click the + sign next to the following widgets to add (if not already selected)
a. Contact Manager
i. Opportunity Financial Data
ii. Opportunity Pipeline
iii. Opportunity Summary
iv. Top Deals
b. Goals
i. Sales Vs. Goals
ii. Sales Vs. Goal Over Time
c. None
i. Shortcuts
11.Select Saved Dashboards in the pop-up window
12.Select the radio button in the Firm Default column for the newly created Firmwide
Dashboard.

accomplished by checking the box at the top of the Shortcut widget settings

It is helpful to include the Shortcuts widget set to a toolbar. This can be
0 window for Add shortcuts to toolbar (only one per dashboard tab allowed)

Activity 13.2 — Set Up A Business Development Dashboard And

Make It Public
This activity guides you in adding recommended widgets, but not customize them,
as these are very flexible to meet each firm’s needs

Activity Steps
1. Go to the Home page
Open the Dashboard: dropdown menu at the top left of the dashboard
Select the Executive Dashboard
Select Save Dashboard As
In the pop-up window, type “BD Dashboard”
Click OK
Open Dashboard Settings at the top right of the dashboard
In the Tab Title, type “My Metrics”
Click the + sign next to the following widgets to add (if not already added)
a. Activities
i. Events
i. Goal Progress w/history
b. Contact Manager
i. Hit Rate
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ii. Opportunity Analysis
iii. Opportunity Financial Data
iv. Opportunity Pipeline
v. Opportunity Summary
vi. Sales Goal Gauge
vii. Top Deals
viii. Win Rate
c. Goals
i. Sales Vs. Goals
i. Sales Vs. Goal Over Time
10.Select Saved Dashboards
11.In the row for BD Dashboard, click the lock icon so that it shows unlocked to make a
public dashboard

Working with Widgets
The Dashboard is where you install widgets that bring information and data to a central
portal for you to access and analyze quickly.

This activity guides you in adding recommended widgets, but not customize them,
as these are very flexible to meet each firm’s needs.

@ Demo 13.3 — Disable a widget and export a widget

Activity Steps
Part 1: Disable a widget

1. From the Home page, open Dashboard Settings L Dashboard Settings 4t the top
right of the dashboard

Select Administration

Find the Revenue vs Goal widget

Click the blue Enabled label next to the widget name

Select the x in the top-right corner of the Dashboard Settings window to close the
window

abkown

Part 2: Export a widget

1. In the banner of the Opportunity Summary widget, find and click the export icon

(the fourth icon displays as a floppy disk).

Copy the URL created in the pop-up window

Paste the URL in a desired place to embed

4. To view a list of your firm's embedded widgets, go to Dashboard Settings >
Exported Widgets.

w N
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0 Once an exported widget is embedded, the widget stays updated with data from

the Unanet CRM account.

Demo 13.4 — Customize the Opportunity Financial Data widget
This activity guides you in customizing the Opportunity Financial Data widget so
that you can see the various ways you can use it, as it is the most flexible widget.

Activity Steps

Part 1: Customize as a Headline report displaying total open pursuits by an office

1.

From the Home page, open the Firmwide Dashboard from the Dashboard selection
dropdown menu

2. Open the Settings for the Opportunity Financial Data widget by clicking on the gear
icon (fourth icon from the left)
3. Select the Chart Type dropdown, and select Headline
4. Change the Title to “[type in the name of office] Open Pursuits Total”
5. Adjust Fee Type
a. Sum
b. Firm Estimated Fee
6. Open the Stage Types tab
a. Check only Open and Pending
7. Scroll tabs over and open the Offices tab
a. Check the box next to the Office for which you are creating this Opportunity
Financial Data widget only
8. Click Save
9. Re-open Settings and change Height to 75
10.Click Save

Part 2: Customize as an “All Open Pursuits by Office” List Results widget

1.

o0k wN

Clone the widget from Part 1 by clicking the clone icon (second to last icon before the
“)
Open the Settings for the cloned widget
Change the Title to “All Open Pursuits by Office”
Change Chart Type to List Results
Change Height to 300
Select the Offices tab
a. Uncheck the office currently selected
Click Save
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Part 3: Customize as a Multi-Series List
1. Clone the widget from Part 2
2. Open Settings for the cloned widget
3. Change the Title to “All Open Pursuits by Office and Stage”
4. Change Chart Type to Multi-series List Results
5. Select the following
a. Group 1: Offices
b. Group 2: Stages
6. Open the Offices tab to ensure all unchecked
7. Open Stage Types
a. Check Open
b. Check Pending
8. Open the Stages tab
a. Check submitted stages, for example, Qualifications Submitted, Shortlisted,
Submitted RFP, Interviewed
9. Click Save

Part 4: Customize for a Chart
1. Clone the widget from Part 3
2. Open Settings for the cloned widget
3. Change Chart Type to Multi-series Column 2D
4. Click Save

Activity 13.5 — Customize the Sales vs Goal widget
0 This activity guides you in customizing the Sales vs. Goal widget to show the
percentage of the goal for a specific office.

Activity Steps
1. From the Home page, open the Firmwide Dashboard from the Dashboard selection
dropdown menu
2. Open the Settings for the Sales vs Goal widget
3. Change the Title to “Orlando % of Goal” (Select an office you have listed in our
sandbox)
Change Chart Type to % of Goal
5. Set the following:
a. Year Count: 1
b. Series 1: Offices
c. Goal Type: Sales Goal
6. Open the Actual Settings tab and select the following
a. Fee Source: Firm Estimated Fee
b. Date Source: Close Date
7. Open the Stages tab and check Closed Won

s
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8. Scroll over in the tabs and select the Offices tab, then select a city
9. Click Save

Activity 13.6 — Customize the Top Deals widget

This activity guides you in customizing the Top Deals widget to show the 10 Open
Pursuits Firmwide.

Activity Steps

1. From the Home page, open the Firmwide Dashboard from the Dashboard selection
dropdown menu

2. Open the Settings gear icon for the Top Deals widget
3. Ensure the following are selected:

a. Fee Type: Firm Estimated Fee
b. Item Label: Opportunity Name

c. Check the option for “Include the total of your top opportunities in the
title”

4. Open the Stage Types tab and select
a. Open
b. Pending

5. Click Save

You can easily configure the Top Deals widget as a Top Wins YTD or Top
Losses YTD report by adjusting the Filters > Close Date and updating Stage

Types. You can also configure the Top Deals widget to include only certain offices
or roles.

Check your understanding

Where can Dashboards be customized?
a) My Preferences
b) Dashboard Settings
c) General Administration

O Refer to Appendix A for answers to the Check Your Understanding questions.
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LESSON 14: RUN AND ANALYZE REPORTS

Learning Objectives
¢ Navigate the Reports module
e Build and run a standard opportunity report by groups
e Build and run a standard opportunity hit rate report
¢ Maintain reports in the Report Manager

Introduction
The Reports module components share names with the core data modules and features—

e Project e Contact

e Opportunity e Company
e Survey e Activity

e lead e Personnel

The other available component reports are as follows:

e Grouped Reports — Links o Stats — Lists what reports have
several individually created been recently run, and how many
reports together so they can be times
generated into one document, o System Activity — Lists the
creating one report from many system messages created in

project publications by activity,
modification type, and date

The tabs on the main page allow you to move between four different report types:

o My Last Viewed Reports — Most e All Reports — All Standard
recently run by your user account Reports, plus all public reports

e My Private Reports — Created created by all of the user
by your user account and set as accounts within your firm. Firm
private Administrators can see all reports

e My Reports — Created by your
user account and set as public

Note: When viewing a report grid, refer to the legend located at the bottom of each list
of reports. The legend includes the below icons:

! Customize [] Standard Ed Excel ® Public @ Private W Delete



e Customize - Edit the report
e Standard - Structured report
e Excel — Export to excel

Notable Column Headers
e Status - indicates if a report has been marked Public or Private.
e Delete — Select the trashcan icon to delete the report

¢ Time column indicates how long it takes to run the report. The longer a report
takes to run, the more results it returns.

@ Tour 14.1 — Navigate the Reports module
Tour the Reports module and discover functionality.

Build and Run Reports
Creating a report in the Reports module follows a primary sequence of steps:
1. Select available fields (fields vary by report type).
2. Select criteria and filters.
3. Select additional options, including the order of the selected fields.
4. Select the sort order.
5. Select Group-By Field settings.

Saving a report doesn’t save the report's results; it saves the selected criteria
created to run that report.

Activity 14.2 — Build and run a standard Opportunity report by
groups

This activity will build a basic Opportunity report utilizing just a few fields and
the Group-By Fields feature

Activity Steps

1. Open the Reports module from the left-side menu
2. Select the Opportunity tab along the top row
3. Click the Create Custom Report button at the top-right
4. Select the following fields

a. Opportunity Name

b. Stage
5. In the Limit by Date section, select

a. Date Created

b. Relative Date

i. Only in the Previous 365 Days

6. Click Save and Continue



7.

In the Group By Fields box, select Primary Grouping: Stage
8. Click Save and Continue

Activity 14.3 — Build and run a standard Opportunity Hit Rate
report
In this activity, you build an Opportunity report specific to hit rates

Activity Steps
Open the Reports module from the left-side menu

1.
2
3.
4. Select all of the available fields
a.
b.

c.
d.

o

. Select the Opportunity tab along the top row

Click the Create Custom Hit Rate Report button at the top-right

e

Total: Wins, Losses, Pending
Declared Wins

Declared Losses

Pending

Hit Rate for Declared Status Pursuits

In the Group By section, select Offices
In the Close Date Filter section, select

a.
b.

Between 1/1/2020
And 12/31/2020

Click Generate Report
Maintaining the Report Manager

An Administrator can search for, filter, view, customize, group, sort, export, and delete
reports on the Report Manager tab.

Note: You can filter and search on the Reports Manager tab, which you cannot from
Reports Home.

You can create a more custom Hit Rate report by building a standard
Opportunity report, but then choose the Show Hit Rate Calculations
option in the second criteria screen in the Group By Fields section.

@ Tour 14.4 — Maintain reports in the Report Manager
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Check your understanding

True or False
My Reports contains reports created by your user account and set as public
and private.

a Refer to Appendix A for answers to the Check Your Understanding questions
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LESSON 15: CREATE AND MAINTAIN THE
KNOWLEDGE MODULE

Learning Objectives
e Set up file structure
e Upload and create content (knowledge bits)

Introduction

The Knowledge Module is used to store useful, non-project-specific information such as
standard narratives and proposal responses, firm documentation and statistics, safety
information, community involvement, financials, and even internal Unanet CRM training
documentation. It serves very useful providing a single source of truth for answers to
common questions, standard narratives, and the parts and pieces you might need to
populate a proposal.

The Knowledge Module home page shows the Category Structure that displays links to
available knowledge categories you create. These categories are similar to folders in
Windows Explorer. Each category shows the number of Knowledge records (or bits)
entered in parenthesis after the category name.

Once you create a Knowledge record, you can assign additional categories, upload
images, and documents, or link project and opportunity records. Be sure to use the
Category Structure tab to create knowledge bits, and use the Edit Categories tab to
add, delate, rename, or order categories and subcategories.

0 Activity 15.1 — Set up file structure
Activity Steps

Part 1: Create a category
1. Open the Knowledge module from the left-side menu
2. Select the Edit Categories tab in the top-right of the screen
3. Click the +Category button
4. In the pop-up window, for Category Name, type “Miscellaneous”
5. Click Save

Part 2: Create subcategories
1. If not already open, select the Edit Categories tab
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Open the Miscellaneous folder

In the Sub Categories box, click the +Category button

In the pop-up window, for Category Name, type “Equipment/Software”
Click Save

Click the +Category button in the Sub Categories box

In the pop-up window, for Category Name, type “Support Services”
Click Save

Part 3: Reorder subcategories

1.

oA WN

If not already open, select the Edit Categories tab
Open the Proposal > Approach folder

In the Sub Categories box, click Order Categories
Select QA/QC

Click the up arrow

Click Save

Part 4: Delete a subcategory

1

2.
3.
4.

See Appendix B — Knowledge Module Cateqgory Structures for two recommended

If not already open, select the Edit Categories tab

Select Proposal > TOC

In the Current Category box, click the Delete trash can icon
Click OK

structures (one of which we built in the previous activity)

0 Activity 15.2 — Upload and create content (knowledge bits)

Activity Steps

Part 1: Create a new knowledge record (knowledge bit)

1

2.
3.
4.

5.

Open the Category Structure tab
Select Proposal > Graphics
In the Marketing section, click the +Knowledge button
Enter the following information

a. Title: Company Logo

b. Description: This is the standard company logo
Click Save

Part 2: Add details

6. On the next screen, VIEW MARKETING KNOWLEDGE, perform the following:

a. In the Categories box, click +Category
i. Select Marketing Collateral
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ii. Check the box for Marketing Collateral at the top of the list
b. In the Images box, click +Category
i. Select Choose File for Full Size Image
1. Choose any .jpg or png file (do not include special
characters in file name)
2. Click Save
c. Inthe Companies box, click +Company
i. Search for and select a Company
ii. Click Save

Part 3: Assign Unassigned Knowledge
1. Open the Unassigned Knowledge tab
2. Open Test Project Knowledge Bit
a. In the Categories box, click +Category
i. Select Proposal
ii. Select Design Approach
3. Click Save

Check your understanding

True or False
The Edit Categories tab is where you create Knowledge bits.

O Refer to Appendix A for answers to the Check Your Understanding questions
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LESSON 16: CREATE AND SET UP WORKFLOWS

Learning Objectives
e Create a reminder workflow for when an Activity is coming due
e Create a notification workflow for when an Opportunity is created/changed
o Create a set action workflow to change the Opportunity Stage when the Proposal
Due Date has passed

Introduction
Work Flow 2.0 is located in the Administration module and allows you to automate
operations within the system.

A Workflow consists of an initiated Action when an Event affects a Resource (record
or entry type). For example, many accounts set up a Workflow that sends an Email
notification= (Action) when an Opportunity = (Resource) is created = (Event).

The following are available as Workflow Events:

e Convert (when a user or integrated system converts a Lead or Opportunity to an
Opportunity or Project, respectively)

e Create (when a user or integrated system creates a record or entry)

o Date Trigger (when the current date matches a relative amount of time
determined by a Workflow, such as "Proposal Due Date is 30 Days from now")

e Send to External System

e Update (when a record or entry is edited/modified)

e Delete (when a user or integrated system deletes an entry)

Note: Available Events vary depending on the selected Resource.

The following are available as Workflow Actions:
e Email (sends an email to designated recipients)
¢ Notification (sends a push notification to designated recipients)
e Set ("sets" a designated field to a specified value. Number/dollar fields can be
set equal to custom calculations)
e Webhook (sends an API call to an assigned destination)

Here are three practical examples to walk through to understand how to create a
Workflow.
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Demo 16.1 — Create a reminder Workflow for when an Activity is
coming due

Demo Steps

Part 1: Create the Workflow

1. Click the Administration Ed button

a. Hover over General Administration

b. Select Workflow 2.0 from secondary dropdown menu
Click the + New Workflow button on the top-left of the module
Type “Proposal Due Date 1 Week Notification” in the Name field
For the Resource dropdown, select Opportunity
For the Event dropdown, select Date Trigger

aobkrowdn

Part 2: Build the Workflow
1. For the bottom pane, select the Workflow Actions tab
Click the +Add Action button
Select Email
Fill out To: Entire Staff Team
Fill out Subject: Proposal due date is 1 week away
In the message box, fill in the following:
a. Opportunity Name
i. Click Insert Variable and find and select Name
b. Type Opportunity Number
i. Click Insert Variable and find and select Opportunity Number
c. Type Link
i. Click Insert Variable and find and select Link
d. Type Proposal Due Date
i. Click Insert Variable and find and select Proposal Due Date
Select the Event: Date Trigger tab
8. For the Trigger when dropdown, select:
a. Proposal Due Date
b. is 7 days from now
9. Select the Workflow Summary tab to review the workflow
10.Click Save

SN o
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Part 3: Make the Workflow active
1. Click the blue Draft label next to newly created Workflow
2. Select Activate from the pop-up menu
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0 Activity 16.2 — Create a notification Workflow for when an
Opportunity is created/changed

Activity Steps

Part 1: Create the Workflow

1. Click the Administration Ed button

a. Hover over General Administration

b. Select Workflow 2.0 from secondary dropdown menu
Click the + New Workflow button on the top-left of the module
Type “Opportunity Modified Notification” in the Name field
For the Resource dropdown, select Opportunity
For the Event dropdown, select Update

aobkrowdn

Part 2: Build the Workflow
1. For the bottom pane, select the Workflow Actions tab
Click the +Add Action button
Select Email
Fill out To: Staff Team: Project Manager
Fill out Subject: Opportunity Modified Notification
In the message box, fill in the following:
a. Opportunity Name
i. Click Insert Variable and find and select Name
b. Type Opportunity Number
i. Click Insert Variable and find and select Opportunity Number
c. Type Client Name
i. Click Insert Variable and find and select Client Name
d. Type Link
i. Click Insert Variable and find and select Link
7. Select the Event: Update Filters tab
8. Select the Resource: Opportunity Filters (after update) tab
9. Click + Add Filter
10.Fill in the following:
a. Proposal Submitted
b. has changed
11.Select the Workflow Summary tab to review the workflow
12.Click Save

o0k N

Part 3: Make the Workflow active
1. Click the blue Draft label next to newly created Workflow
2. Select Activate from the pop-up menu
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0 Activity 16.3 — Create a set action Workflow to change the
Opportunity Stage when the Proposal Due Date has passed

Activity Steps

Part 1: Create the Workflow

1. Click the Administration Ed button

a. Hover over General Administration

b. Select Workflow 2.0 from secondary dropdown menu
Click the + New Workflow button on the top-left of the module
Type “Opportunity Stage Date Trigger” in the Name field
For the Resource dropdown, select Opportunity
For the Event dropdown, select Date Trigger

aobkrowdn

Part 2: Build the Workflow
1. For the bottom pane, select the Workflow Actions tab
2. Click the +Add Action button
3. Select Set
4. Click +Add Value
5. Fill in the following
a. Stage
b. Equal to
c. 06-Submitted RFP
Select the Event: Date Trigger tab
7. Fill in the following:
a. Trigger when Proposal Due Date
b. is 1 day ago
8. Select the Workflow Summary tab to review the workflow
9. Click Save

o

Part 3: Make the Workflow active
1. Click the blue Draft label next to newly created Workflow
2. Select Activate from the pop-up menu



0 Activity 16.4 — Use a notification Workflow to create a project
setup form that gets sent to accounting

Activity Steps

Part 1: Create the Workflow

1. Click the Administration Ed button
a. Hover over General Administration
b. Select Workflow 2.0 from secondary dropdown menu
Click the + New Workflow button on the top-left of the module
Type “Opportunity Closed Won — Notify Accounting” in the Name field
For the Resource dropdown, select Opportunity
For the Event dropdown, select Update

aobkrowdn

Part 2: Build the Workflow
1. For the bottom pane, select the Workflow Actions tab
2. Click the +Add Action button
3. Select Email
4. Fill out To: Other > accounting@xyz.com
5. Fill out Subject: Opp Closed Won
a. Click into message are and find the variable for Opportunity Number and
paste in Subject %opportunity.oppnumber%
6. In the message box, fill in the following:
a. Opportunity Name
i. Click Insert Variable and find and select Name
Type Opportunity Number
i. Click Insert Variable and find and select Opportunity Number
. Type Client Name
i. Click Insert Variable and find and select Client Name
. Type Closed Date
i. Click Insert Variable and find and select Client Name
e. Type Link
i. Click Insert Variable and find and select Link
7. Select the Event: Update Filters tab
8. Select Resource: Opportunity Filters (after update) tab
a. Click +Add Filter and fill in the following
i. Stage equals Closed Won
ii. Stage has changed
9. Select the Workflow Summary tab to review the workflow
10.Click Save

o
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Part 3: Make the Workflow active
1. Click the blue Draft label next to newly created Workflow
2. Select Activate from the pop-up menu

0 Activity 16.5 — Create a notification Workflow to send email
with set action link to change an Opportunity stage

Activity Steps

Part 1: Create the Workflow

1. Click the Administration E& button
a. Hover over General Administration
b. Select Workflow 2.0 from secondary dropdown menu
Click the + New Workflow button on the top-left of the module
Type “Opportunity Proposal Past Due — Set Stage” in the Name field
For the Resource dropdown, select Opportunity
For the Event dropdown, select Date Trigger

aobkrown

Part 2: Build the Workflow
1. For the bottom pane, select the Workflow Actions tab
2. Click the +Add Action button
3. Select Email
4. Fillin the following
a. To: Other - director@xyz.com
b. CC: Firm Marketing Reviewers
c. Subject: Opportunity Proposal Due date has Passed — Please Update
Stage Link”
i. Click into message are and find the variable for Opportunity
Number and paste in Subject %opportunity.oppnumber%
5. In the message box, fill in the following:
a. Opportunity Name
i. Click Insert Variable and find and select Name
b. Type Opportunity Number
i. Click Insert Variable and find and select Opportunity Number
c. Click Insert Variable and open General > Set Action Link
i. Fillin the following:
1. Label: Set Stage = “Did Not Pursue”

ii. Field: Stage
iii. Value: Inactive/Did Not Pursue
d. Click Ok

6. Select the Resource: Opportunity Filters tab
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7. Click +Add Filter and fill in the following:
a. Proposal Submitted equals No
8. Select the Event: Date Trigger tab
9. Fillin the following:
a. Trigger when Proposal Due Date
b. is 1 day ago
10. Select the Workflow Summary tab to review the workflow
11.Click Save

Part 3: Make the Workflow active

1. Click the blue Draft label next to newly created Workflow
2. Select Activate from the pop-up menu

Check your understanding

Identify the Resource, Event, and Action for the example Workflow:

Notify OFA when a new Company is created

O Refer to Appendix A for answers to the Check Your Understanding questions
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LESSON 17: CONFIGURE FIRM SETUP AS THE OFA

Learning Objectives
¢ Navigate the Firm Setup tab for enabling and relabeling features
e Modify Firm Org value lists

Introduction

The "Firm Setup" area offers many options for configuring the database. These options
are only accessible to the Overall Firm Administrator (OFA). The OFA can turn tabs and
functions on or off across different modules within this menu. Most of these
configurations are determined and set up during implementation. However, some
options may require occasional attention.

Firm Setup

In General Administration > Firm Setup, you can upload a company logo and add the
company name to the left-side menu. It's also where you can enable Opportunity
Forms, Convert Lead to Opportunity, and enable the ability to Make a User from a
Personnel record.

Two essential sections near the top of the page are FIRM ORG and RELABEL FIRM
ORG NAMES. A table in the FIRM ORG section displays the core data modules as
rows and the Firm Orgs as columns to select or deselect. It also indicates a single-
select option. It is imperative to organize your information the same way your firm is
organized.

FIRM ORG

Offices Divisions Office Division Studios Practice Areas Territories

a
a
a
a

Projects [ single-select B (single-select) [Jsingle-select ([ single-select) [single-select)

single-select)

a
a
a
a

Opportunities [ single-select B (Osingle-select) [ single-select [ single-select) [ single-select)

single-select)

[ single-select O

[ single-select

a
Q
a
a

Contacts single-select) [ single-select)

a
Q
a
a

Companies B (Osingle-select) single-select) Csingle-select)

4]
Q
<]
4]

Personnel [ single-select; B (single-select) [ single-select [ single-select) [Csingle-select)

(
(

B (Osingle-select)
(
( single-select)
(

(
(
( Osingle-select)
(
(
(

( ) ( )
( ) ( ) (
( ) ( ) (
(O single-select) (O single-select) (O single-select)
( ) ( ) (
( ) ( ) (

4,

Leads

4]
4]
4]

[ single-select B ([single-select) [Jsingle-select [Jsingle-select) [single-select)

single-select)

In the RELABEL FIRM ORG NAMES section, you can relabel Offices, Divisions,
Office Divisions, Studios, Practice Areas, and Territories.
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@ Tour 17.1 — Navigate the Firm Setup tab for enabling and

relabeling features

Firm Org

Access the Firm Org menu from the left-side navigation. Here, you add, delete, and edit
the Firm Orgs to mirror your company structure. Note: You turn the Firm Org values on
or off for modules and relabel them in General Administration > Firm Setup.

The Firm Orgs describe your firm's internal organizational structure. Creating this
hierarchy allows you to assign your Personnel, Companies, Contacts, Leads,
Opportunities, and Projects to your firm's physical locations and work-specific areas.

The Firm Org module includes seven areas:

1.

Firm — stores your firm's primary contact and corporate information. To edit this
information, click the "Edit" button, enter all desired data, then click the "Save"
button.

Offices - stores the contact and corporate information for your firm's physical
locations.

Divisions - stores the contact information for your firm's defined work-specific
areas.

Studios - allows you to designate further breakdowns of your internal structure.
Practice Areas - allows you to designate further breakdowns of your internal
structure.

Office Division - stores information regarding the relationship between your
Offices and Divisions.

Territories — stores sales territory breakdowns based on zip codes.

Activity 17.2 — Modify Firm Org value lists
In this activity, you add and remove values to and from the Firm Org value list
Offices.

Activity Steps

Part 1: Add an Office

1

2,
3.
4.

Open the Firm Org module from the left-side menu
Open the Offices tab from the top row
Click the +Offices button in the top-right
Type in the indicated fields:
a. Offices Name: Boston
b. Acronym: BOS
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5.

6.

In the BUSINESS ADDRESS section, select
a. Country: United States
b. State: Massachusetts

Click Save at the top-right

Part 2: Remove an Office

1.

©ooNOORWDN

Open the Offices tab from the top row

Find the row for Phoenix

Click the trash can icon in the Delete column

Select OK from the pop-up window

Click the text Denver to open the Denver Office

Click the Edit button in the top-right

Go to the bottom of the GENERAL INFORMATION section
Select No for Available on the drop-down menu?

Click Save in the top-right

Check your understanding

O Refer to Appendix A for answers to the Check Your Understanding questions.

The Firm Setup tab allows you to

a) Create new Firm Org values
b) Create new Firm Orgs
c) Relabel Firm Orgs
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APPENDIX A: Check Your Understanding Answer Key

Lesson 1: Customize Basic Firm Settings and Understand Navigation

The modules considered core data modules that store and track all of your
data are

h) Companies

i) Contacts

j) Leads

k) Opportunities
[) Personnel

m) Projects

n) All of the above

Value Lists are located in
a) General Administration
b) Activities Administration
c) Contact Manager Administration
Lesson 2: Create Personnel Records

True or False
Personnel records store data used for resumes.

Lesson 3: Utilize My Preferences
Preferences include options to
a) Create a Dashboard

b) Upload profile picture
c) Associate yourself to a record
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Lesson 4: Configure a Company Record
Which record requires a Company record for association?
a) Contact record

b) Opportunity record
c) Both Contact and Opportunity record

Lesson 5: Configure a Contact Record
What is the best practice for adding a new Contact?

It is best practice to open the company record for which your contact is a
member and search the Contacts table first.

Lesson 6: Configure a Lead Record

True or False
You can enter Leads without associating with any other core data modules

Lesson 7: Configure an Opportunity Record
It is best practice to add an Opportunity record from
a) the + Create New menu

b) a Contact record
c) a Company record

Lesson 9: Configure Forms
True or False

The Go-No Go Simple and Go-No Go Advanced Form is the only template
provided among several others.

Lesson 10: Configure a Project Record

Which tab in the Project record has its own management tool?
Project Image Manager
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True or False
A Project can be created from the Opportunity record.

Lesson 11: Configure Projects Administration

True or False
The Administrate Project Fields Display Labels page is used to customize
fields and include or exclude fields on Project forms.

Lesson 12: Utilize the User Manager to Set Permissions

True or False
Permissions must be set on a user group before adding users.

Lesson 13: Set Up and Distribute Dashboards

Where can Dashboards be customized?
a) My Preferences
b) Dashboard Settings
c) General Administration

Lesson 14: Run and Analyze Reports

True or False
My Reports contains reports created by your user account and set as public

and-private

Lesson 15: Create and Maintain the Knowledge Module

True or False
The Edit Categories- Category Structure tab is where you create Knowledge
bits.
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Lesson 16: Create and Set Up Workflows

Notify OFA when a new Company is created
« Resource: Company

e Event: Create
e« Action: Emalil

Lesson 17: Configure Firm Setup as the OFA
The Firm Setup tab allows you to
a) Create new Firm Org values

b) Create new Firm Orgs
c) Relabel Firm Orgs
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APPENDIX B: SUPPLEMENTAL INFORMATION

Sample Value Lists

Construction

Architecture Engineering

Condominiums/Apartments
Convention Center
Correctional Facility

Commercial Commercial

Practice Criminal Justice Criminal Justice

Area Education Education

Government Government
Healthcare Healthcare
High Tech High Tech
Hospitality Hospitality
Industrial Industrial
Leisure Leisure
Manufacturing Manufacturing
Religious/Cultural Religious/Cultural
Airport Airport

Primary Charter School Charter School

Categories | Church Church

Clinic Clinic

Condominiums/Apartments
Convention Center
Correctional Facility

Core and Shell Only
Data Center/Web Hotel
Emergency Room

Courthouse Courthouse

Dormitory/Barracks Dormitory/Barracks

Hangar Hangar

Higher Education Higher Education

Hospital Hospital

Hotel/Motel Hotel/Motel

K-12 K-12

Auditorium Auditorium
Secondary | Baggage Claim Baggage Claim
Categories | Biotech Biotech

Bridge Bridge

Building Information Modeling Building Information Modeling

(BIM) (BIM)

Classrooms Classrooms

Clean Room Clean Room

Core and Shell Only
Data Center/Web Hotel
Emergency Room
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Food Service

Food Service

Laboratory Laboratory
Library Library
Occupied During Construction Occupied During Construction
Accounting Accounting
Contact Decision Maker Decision Maker

Type Gatekeeper Gatekeeper
Influencer Influencer
Manager Manager
Marketing/BD Marketing/BD
Project Site Project Site
Estimator Design Lead

Staff Team | Lead Business Developer Lead Business Developer

Roles Project Engineer Principal-in-Charge
Project Executive Project Engineer
Project Manager Project Manager
Superintendent
Lead Estimator
01-Prospecting 01-Prospecting

Opportunity | 02-Received RFQ 02-Received RFQ
Stage 03-Qualifications Submitted 03-Qualifications Submitted

04-Shortlisted to Proposal
05-Received RFP
06-Proposal/Bid Submitted
07-Shortlisted to Interview
08-Interviewed

09-Verbal Award
10-Closed Won

11-Closed Lost
12-Inactive/Did Not Pursue
13-On Hold

04-Shortlisted to Proposal
05-Received RFP
06-Proposal Submitted
07-Shortlisted to Interview
08-Interviewed

09-Verbal Award
10-Closed Won

11-Closed Lost
12-Inactive/Did Not Pursue
13-On Hold
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Permission Lists

FULL LICENSE TYPE PERMISSIONS

Administration

Workflow

App Market

Contact Manager

Activities

Activities

Move User Groups
Change Group Permissions
Change User Permissions
Login as User

Login as Extranet User
Quick Search Admin

Full Read

Full Write

Full Delete

Full Admin

Browse

Config

Install

Purchase

Admin

Full Read

Full Write

Full Delete

Full Admin

Self Read

Self Write

Self Delete

Firm Org Read

Firm Org Write

Firm Org Delete

Company Full Read

Full Read

Full Write

Full Delete

Full Admin

Opportunity Self Read
Opportunity Self Write
Opportunity Self Delete
Opportunity Firm Org Read
Opportunity Firm Org Write
Opportunity Firm Org Delete
Contact Self Read
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Leads

Leads

Contact Self Write
Contact Self Delete
Contact Firm Org Read
Contact Firm Org Write
Contact Firm Org Delete
Personnel Self Read
Personnel Self Write
Personnel Self Delete
Personnel Firm Org Read
Personnel Firm Org Write
Personnel Firm Org Delete
Project Self Read
Project Self Write
Project Self Delete
Project Firm Org Read
Project Firm Org Write
Project Firm Org Delete
Company Self Read
Company Self Write
Company Self Delete
Company Firm Org Read
Company Firm Org Write
Company Firm Org Delete
Lead Self Read

Lead Self Write

Lead Self Delete

Lead Firm Org Read
Lead Firm Org Write
Lead Firm Org Delete
Activities Self Write
Activities Self Read
Activities Self Delete

Full Read

Full Write

Full Delete

Full Admin

Self Read

Self Write

Self Delete
Firm Org Read
Firm Org Write
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Opportunities

Dashboard

Email

Email 3.0

Email Marketing

Email Marketing
Firm Org

Firm Org Delete

Full Read

Full Write

Full Delete

Full Admin

Self Read

Self Write

Self Delete

Firm Org Read

Firm Org Write

Firm Org Delete

Push To Partner Vendor
Read From Partner Vendor
Generate Proposal Number
Full Write Limited

Full Write Stage

Full Write Project Probability
Self Write Limited

Self Write Stage

Self Write Project Probability
Firm Org Write Limited
Firm Org Write Stage
Firm Org Write Project
Probability

Take Snapshot

Edit Snapshot

Full Read

Full Write

Full Delete

Full Admin

Full Read

Full Write

Full Delete

Full Admin

Full Read

Full Write

Full Delete

Full Admin

Full Read

Full Write

Full Delete
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Goals

Knowledge

Personnel

Projects

Publisher 4.0

Publisher 4.0

Reports

Full Admin

Full Read

Create

Modify

Delete

Full Read

Full Write

Full Delete

Full Admin

Full Read

Full Write

Full Delete

Full Admin

Self Read

Self Write

Full Read

Full Write

Full Delete

Full Admin

Self Read

Self Write

Self Delete

Firm Org Read

Firm Org Write

Firm Org Delete

View Full Import Log
View Self Import Log
View Firm Org Import Log
Push To Partner Vendor
Read From Partner Vendor
Edit Web Descriptions
Publish To Website
Marketing Project
Publishable Project
Full Read

Full Write

Full Delete

Full Admin
Publishable Project Filter
Full Read

Full Write
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Full Delete
Full Admin
Project Type Filter

CRM LICENSE TYPE PERMISSIONS
Administration
Workflow Full Read
Full Write
Full Delete
App Market Browse
Config
Install
Purchase
Contact Manager  Full Read
Full Write
Full Delete
Self Read
Self Write
Self Delete
Firm Org Read
Firm Org Write
Firm Org Delete
Company Full Read
Activities Full Read
Full Write
Full Delete
Opportunity Self Read
Opportunity Self Write
Opportunity Self Delete
Opportunity Firm Org Read
Opportunity Firm Org Write
Opportunity Firm Org Delete
Contact Self Read
Contact Self Write
Contact Self Delete
Contact Firm Org Read
Activities Contact Firm Org Write
Contact Firm Org Delete
Personnel Self Read
Personnel Self Write



Leads

Opportunities

Opportunities

Personnel Self Delete
Personnel Firm Org Read
Personnel Firm Org Write
Personnel Firm Org Delete
Project Self Read

Project Self Write
Project Self Delete
Project Firm Org Read
Project Firm Org Write
Project Firm Org Delete
Company Self Read
Company Self Write
Company Self Delete
Company Firm Org Read
Company Firm Org Write
Company Firm Org Delete
Lead Self Read

Lead Self Write

Lead Self Delete

Lead Firm Org Read
Lead Firm Org Write
Lead Firm Org Delete
Activities Self Write
Activities Self Read
Activities Self Delete

Full Read

Full Write

Full Delete

Self Read

Self Write

Self Delete
Firm Org Read
Firm Org Write

Firm Org Delete

Full Read

Full Write

Full Delete

Self Read

Self Write

Self Delete
Firm Org Read
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Firm Org Write

Firm Org Delete

Push To Partner Vendor
Read From Partner Vendor
Generate Proposal Number
Full Write Limited

Full Write Stage

Full Write Project Probability
Self Write Limited

Self Write Stage

Self Write Project Probability
Firm Org Write Limited

Firm Org Write Stage

Firm Org Write Project Probability

Dashboard Take Snapshot
Edit Snapshot
Email Full Read
Email 3.0 Full Read
Email Marketing  Full Read
Firm Org Full Read
Goals Full Read
Create
Modify
Delete
Knowledge Full Read
Full Write
Full Delete
Full Admin
Personnel Full Read
Self Read
Projects Full Read
Full Write
Self Read
Self Write
Projects Firm Org Read

View Full Import Log

View Self Import Log
Projects View Firm Org Import Log

Read From Partner Vendor
Publisher 4.0
Reports Full Read



Full Write
Full Delete
Project Type Filter

READ ONLY LICENSE TYPE PERMISSIONS

Workflow Full Read

Contact Manager  Full Read

Self Read
Firm Org Read
Company Full Read

Leads Full Read
Self Read
Firm Org Read

Dashboard

Email 3.0 Full Read

Firm Org Full Read

Knowledge Full Read

©2024 Unanet. All rights reserved.
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Personnel

Projects

Full Read

Self Read

Full Read

Self Read

Firm Org Read

View Full Import Log

View Self Import Log

View Firm Org Import Log
Read From Partner Vendor

Publisher 4.0

Reports

Full Read

Project Merge Fields and Associations

General Information

Project Name

Project Status

Master Project
Converted Opportunity
Account ID

Uses External Data
Project Address Fields
Billing Address Fields
Preferred

Prominent

Completion Date
Federal Work

Project Role

Brief Description
Comments

Proposal Number
Percent Complete

Is Publishable Project
Project Rank

Cost Confidential
NAICS

Notes

Custom Fields
Multi-Select Information:
Firm Org Offices

Firm Org Divisions

Firm Org Studios

Firm Org Practice Areas
Firm Org Territories
Primary Categories
Secondary Categories
Service Types
Construction Types
Delivery Method
Contract Type

Client Type

SF330s & SF254
Publishable Reasons
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Project Tabs

e Owner/Client Information
Staff Team
Consultant Information
Fees/Costs
Costs
Change Orders
Project Performance
Construction Schedule
A/E Schedule
Size
Descriptions

Documents
Images
Components
Awards
Publications
References
Testimonials
Sub-Contractor
Self-Work
Unions
Properties

Knowledge Module Category Structures

Firm_Intr ion (2]
Business Information (0
................. Acesunting Delisies (0)
................. Business Licenses (0)
----------------- HR Policies fOl
+  Ligbility Coverage {1
Marketing Collateral (3
----------------- Company Background {3}
----------------- General Insurance (0
: + Templates (2}

Proposal (1
“r Cover Page (3)

- TOoC (1)

Eirm Inf ign

Appendix (1}

: +  Graphics {1}

e —— Approach (0}

: - Ability to Mest Schedule/Budgst (1)
s Ability to Work with All (0]
---------------- Design Approach (0]
----------------- Environmental Palicy (0)

+ On-Call / Work Ordars (0}

TP PO Project Management (0]

© QA/oc (0]

Brssssreeni s Equipment | Software (01

+ Support Services (01

Agreements (2
Budgets & Cost Control (0]
Budget Control Graphs & Charts (3)

+ Walue Engineering % Walue Management (3]
-+ Budgest Development (0]
-+ Cost Control (0
-+ Budget & Cost Control Examples (1
Client Survey (5]
Construction Innovations (3]
Construction Methodaologies (1)
faee Alternative Delivery Systems (0]
+ Construction Industrv Institute Best Practictic

-+ Cleanroom Protocol (0}
-+ Design-Build Process (0
-+ Fast-Track Plan (1]
-+ Fixed Mechanization (1]
- Infection Control (1)
- Lean Construction (1)
Diversity (1]
: - In-House Diversity (10)

-+ Community Development - Minority OQutreach
' - Standard Subcontracting Plans (1)

Insurance (3]
Leqal (2]
Management Systems (13)
Market Sectors (8]
Media (1)
feeies PR Plan (0)
E -+ Media Cutreach (0]
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APPENDIX C: CREATING DIFFERENT RECORD
TYPES

Create a Personnel record and make a User
Search for a person’s name before adding a new record to avoid duplication.

Part 1: Create a Personnel record
1. Open the Personnel module from the left menu
2. Click the +Personnel button on the top-right of the table
3. Input required fields
a. First Name - Craig
b. Last Name — Halliday
c. Title- CEO
4. Input additional fields in the EMPLOYMENT HISTORY section
a. Year Started in Industry - 1988
5. Input additional fields in the OFFICE CONTACT section
a. Office Email — craig@unanet.com
6. Input additional fields in PERSONNEL FIRM ORG ASSOCIATIONS section
a. Offices — Washington, DC
Click Save
Open Education tab
Click the +Education button at the top-right
0 In the pop-up window, input the following fields:
a. School — University of Edinburgh
b. Year— 1988
11.Click Save

A@'.@.\‘

Part 2: Make the personnel a user
1. Go back to the Personnel Summary tab
2. Select the +Make User button on top-right
3. In the pop-up window, select CRM User Group
4. Click the Convert to a User button

Create a Company record
1. Add a new Company by clicking the Create New + icon in the upper-right
Select Company
In the Company Name field, type “ABC,” then click on the following field
View the list of similarly named companies
Finish typing “ABC Construction”
Click the green Continue button
Enter the following information in the ADDRESS section (although not required):

Nooakwd
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8. Select the following in the COMPANY FIRM ORG ASSOCIATIONS section

9.

Address 1: 123 Plaza Way
City: Phoenix

Country: United States

State: Arizona

e. Website: www.abc-const.com

apoop

a. Offices: Phoenix
b. Practice Areas: Corporate

Select the OTHER INFORMATION section
a. Company Type: Client

10.Click Save
11.Review the generated Company record

Create a Contact record

1.

IS o

o

Search for ABC Construction using the search field in the header bar.
Open the Company record
Select the Contacts tab along the top row
Verify if the contact already exists
Click the +Contact button in the upper-right of the Contacts section
Enter the following information for the required fields:

a. First Name: Matt

b. Last Name: Jones
Enter the following information:

a. OTHER BUSINESS INFORMATION > Email Address:

mjones@abcconstruction.com

b. OTHER INFORMATION > Contact Type: Decision Maker
Click Save Contact
Review the generated Contact record

Create a Lead record

-_—
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Add a new Lead by clicking the Create New + icon in the upper-right
Select Lead

In the Name field, type “Grocery Store”

In the Potential Client field, type “ABC” to search for ABC Construction
Select ABC Construction

In the Contact First Name field, type “Matt”

In the Contact Last Name field, type “Johnson”

Click Save in the upper-right of the record

Review the generated Lead record
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Create an Opportunity record

1.

2
3.
4

© N

9.
10.
11.

Open up the Company record for ABC Construction

. Select the Associated Opportunities tab along the top

Click the +Opportunity button on the right side of the section

. Enter the following under General Info:

a. Opportunity Name: New School Building
b. Client Company: ABC Construction
c. Stage: 01-Prospecting
In the shortcut panel on the left side, select Categorization
a. For Offices, click +Add and make a selection
b. For Practice Areas, click +Add and select Education
c. For Primary Categories, click +Add and make a selection
d.
In the shortcut panel on the left side, select Staff Team
Click the +Add Staff Team Member button
Search for and select Matt Jones
For Staff Role, open the dropdown and select Assistant Project Manager
Click Add
Click Save at the bottom of the form
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COMPLETION CERTIFICATE AND EVALUATION

Certificate of Completion

Upon course completion, a Certificate of Completion, including applicable CPE credits,

can be downloaded from your Unanet University profile via Unanet’s Experience Center.

Completion status depends on the method used to attend the course:

e Instructor-led training (ILT) courses are marked as “Completed” once Unanet
University staff record attendance.

e Self-Directed Learning (SDL) courses are marked as “Completed” upon
achieving a passing score of at least 70% on the CPE Credit assessment.

To access the Certificate of Completion from your Unanet University profile, navigate to
the = User Menu > My Activities > Courses, locate the completed course, and
select the Q Certificate icon to download.

Course Survey

We appreciate your feedback on our courses and encourage you to complete the
course survey.
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